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Micropay Basics 

 
 
 
 

Starting Micropay 
 
Type in your User ID.  Move to the Password box: use the Enter or Tab keys or click in the Password box.  
Type in your password.  Click the “OK” button to continue or click the “Cancel” button to leave Micropay. 
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Client List Box 

 
The Client List box will appear.  Displayed in the Client List box will be your client number(s) and name(s).  
For most customers only one client will appear in this list.  Click the “OK” button to enter Micropay.  
Customers who have multiple clients must select the client they wish to enter payroll data for.  Click on 
the client to highlight and select it.  Note: By default, the first client in the list is highlighted.  Once the 
selection has been made, click the “OK” button to enter Micropay.   
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Database Functions 

 
 
The Fix Database function will reorganize and compact the Micropay database.  This can be done 
occasionally to help database access speed or if the database should become corrupt.  To use the Fix 
Database feature, select it from the File menu.  This process may take several minutes depending on the 
size of your database. 
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Importing Data 
 
 
The Import feature can retrieve your payroll data from an outside source.  This could be a time clock, 
spreadsheet, or another type of software.  To use the Import feature, it must first be configured with 
ComputerSearch. The vendor of the software program from which the data will be imported from may 
need to be contacted as well. 
 
Once the Import feature has been activated for your payroll, the import-file location will need to be set.  
This is done on the Setup tab of the Import screen.  To access the Setup tab, go to the File menu and 
select Import. Then click the Setup tab.  Set the location of the import-file in the Location box under 
“Import File Location.”  Set the location by entering the path in the Location box or click the “Browse” 
button to find the file on your system.  Once the location of the import-file has been set, click the “Save 
Setting” button. 
 
The contents of the import-file may be viewed by clicking the “View with Notepad” button.  This will bring 
up the file in Notepad.  Changes to the data may be made and saved here.  Note: If changes to the data 
are made here, they will not be made to the original file from which the data came.  Therefore, 
discrepancies will exist when comparing the imported file to that of the original file. 
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To begin the Import process, go to the Import screen.  The file to be imported will be displayed in the 
Location box beneath “Importing.”  If the file exists, the creation date and time of that file are displayed 
beneath it.  If the filename specified does not exist, the error message "File NOT FOUND!" will appear. 
 
To start the Import, first click the “Translate Import File” button.  This formats your data in a way that 
Micropay can read.  Once the translation has finished, you are asked to view the import file.  This will 
allow you to compare the imported file’s information to your records and determine whether the 
translation was successful, i.e., has the correct information.  Next, click the “Apply Transactions to 
Payroll” button and the data will be imported into Micropay. 
 
If you decide that you do not want to apply these transactions to the payroll, they may be removed.  If no 
changes have been made to the payroll data, clicking the “Remove Transactions From Payroll” button will 
take out all the imported transactions.  If changes were made to any transaction in Micropay after it was 
imported, those transactions will not be removed. 
 
A report is available on the import screen toolbar, to display exactly what was imported to the payroll 
system.  This report looks similar to the Micropay time sheet reports, but shows only the imported data. 
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User Management 
 
User management is accessed through the Edit menu.  With user management multiple people can be 
setup to use Micropay each with their own user name and password.  This gives each user access to only 
the information and functions you allow them.  By assigning different security levels, users will be 
restricted to certain information and functions.  Only users with a security level of 1, 2, or 3 may do any of 
the User Management functions. 
 

 
 
 

Creating a New User 
 
To create a new user, click New User on the menu bar.  Enter the User Id in the name field and then 
assign the user a Security Level and password.  Then click the “Save Changes” button. 
 

 
 
 
Please note that the User ID field may contain up to 12 alphabetic characters, while the password field is 
limited to 8 characters. 
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Deleting a User 
 
To delete a user, select the User you wish to delete.  From the menu bar click Delete User.  A message 
will display asking to delete that user?  Click the “Yes” button. 
 
 

 
 

 
Changing a User’s Security Level 

 
To change a user’s security level, go to the Edit menu and then select the Users option.  The User 
Information screen will be displayed with the list of users.  Click on the user whose security level is to be 
changed.  Click in the Security Level box and then type the user’s new security level.  Then click the 
“Save Changes” button. 
 
The available security levels are: 
 
 1, 2, 3 - Able to see/change all rates and able to see YTD/QTD (Earnings Tab on the Employee 
screen) fields. 
 
 4 - Not able to see/change rates flagged by the Hide Time Sheet Rate flag (The General tab on 
the Employee Screen). 
 
 5 - Able to see all rates, but not able to change any rates.  
 
 6 - Able to see/changes Hourly Rates, but not able to see/change Salaried Rates. 
 
 7 - Not able to see/change any rates. 
 
Only users of security levels 1, 2, 3 can: 
 
  -Turn off the Hide Time Sheet Rate flag (The General tab on the Employee Screen). 
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  -See the YTD/QTD earnings fields (The Earnings tab on the Employee screen). 
  -Perform any User Management functions. 
 
 

Changing a User’s Password 
 
To change a user’s password, select the user.  Replace the current password with the new password and 
click the save button that will appear once you start erasing the old password or have selected a user. 
 

 
 
 

Please note that the User ID field may contain up to 12 alphabetic characters, while the password field is 
limited to 8 characters. 

 
 
 
. 
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 Preference Screen 
 
 
The Preference screen is where certain defaults are set for Micropay.  There are four areas available to 
customize:  New Employees, Time Sheet, Tool Bar, and Special Files Location.  The Preference screen is 
accessed through the Edit menu; click the Edit menu and then select the Preference option. 
 

 
 

New Employees Tab  
 
There are five options that are set on the New Employees tab: Sex, State, Rate, Department and Hire 
Date.  Remember: Click the “Save” button, to the right, when you are finished making changes.  If a 
mistake is made, click the “Undo Changes” button immediately, this will restore the previous settings 
(Note: Once changes are saved, “Undo Changes” will not restore the previous settings). 
 

 
 
Sex - May be set to blank or have a default sex selected, Male (M) or Female (F). Note: Micropay will 
warn when an employee does not have a sex entered.  This warning may be turned off here. 
 
State - A default state may be entered, e.g., NY.  All new employees will automatically be coded for that 
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state.  This field may be left blank and the state can be entered when setting up new employees. 
 
Rate - A default rate for new employees may be entered.  If most of your employees start at a particular 
rate, that rate may be entered here and set as the default.  Having a default for both hourly and salaried 
employees is possible.  When a new employee is entered, the hourly rate field will be filled with the 
default rate entered here (see the Monetary tab from the Employee Information Screen).  If the new 
employee is salaried, clear the hourly field (click in the hourly field and press the F2 key), then the 
salaried field will be filled with the default rate for salaried employees. 
 
Department - A default department number maybe entered.  You can choose between the ”000000“ 
option or set a department number (maximum of 6 digits) as the default for new employees.  Validate will 
check the Department table each time a department number is entered and will display an error if the 
department has not been setup. 
 
Hire Date - A hire date may be automatically entered for new employees.  Today’s Date or the Week 
Ending date of the payroll may be used.  If you do not wish to have this field automatically filled, select 
Blank and nothing will be entered.  
 
 

Time Sheet Tab 
 
From this screen the Job Number and Employee Check Digit fields on the Time Sheet can be turned on 
or off.  These fields are both turned off by default.  Click in the box next to the desired field in order to 
have it displayed and available on the Time Sheet screen. If the Time Sheet screen is open, close the 
screen and then reopen it.  The selected field(s) will now be available for use. 
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Tool Bar Tab 
 
The hours entered by the “Regular” and “Holiday” buttons on the Tool Bar used by the Time Sheet screen 
can be customized.  For the “Regular” button you may enter the number of hours to be given to Hourly or 
Salaried employees and the entry code to be used.  For the “Holiday” button, the entries are the same for 
both hourly and salary, i.e., the “Holiday” button will enter hours, on the Time Sheet, for Hourly and 
Salaried employees.  The Temp Rate (see the Time Sheet screen) is zeroed out for the Salaried 
employees.  To make changes, click in the Entry Code and Hours boxes and type the desired values.  
The keyboard shortcut for the “Regular” button is the F5 key and for the “Holiday” button is the F8 key. 
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Special Files Location Tab 
 
If Special Files are to be downloaded from ComputerSearch, a destination for those files will need to be 
specified. 
 

 
 
Clicking the “Browse Folders” button will bring up the Drive and Directory boxes.  Select the drive and 
directory where these files are to be placed. 
 

 
 
Once the location has been selected, click “Save” and the new path will be displayed above the "Browse 
directories" button. 
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Code Tables 
 
Code tables are accessed through the Edit menu; go to the Edit menu and select the Codes option. 
 

 
 
This will bring up the Code Defaults screen.  Here the State, Bank or City Code tables can be selected. 
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State Codes 
 

 
All employees must have a State Code.  Use the State Code in which the employee is working.  To view 
the State Codes go to the Edit menu, then select the Codes options and pick the State Code tab.  The 
State Codes screen shows: the code number for the State, the State’s current “State Unemployment 
Income” (SUI) maximum, the State’s name, Cflag, State abbreviation, and the current default SUI rates.  
Valid codes are from 1 to 52 with New York being 31. See Appendix A for a complete listing of State 
Codes. 
 

 
 
Note: All states require an application for State Income tax, State Unemployment tax and occasionally 
local tax, to be filed.  If your company has employees working in another state, you must file an 
application in that state. 
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Bank Codes  
 
Bank Codes are used for setting up direct deposit for an employee.  The Bank code tells 
ComputerSearch which bank to transfer the employee’s money to.  To change the order in which the 
Bank Codes are displayed pick: Code, Description, or Routing Number.  The Bank Code is the two 
character code from this table, which was entered in the Bank Code field on the Monetary Screen (see 
Monetary section).  Description contains the name of the Bank and Routing Number is the Bank’s transit 
routing number. Contact ComputerSearch for a current listing of Bank Codes. 
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City Codes 
 
The City Codes’ table displays the following information about the City: State Code, City Code, City 
Name, STS State (Code), STS City (Code) and City Percent.  STS stands for the Tax Filing service 
ComputerSearch uses; currently it is Ceridian Tax Service.  City Percent is the rate at which the City 
taxes an employee’s Gross Pay.   
 
City Codes are used to deduct city taxes from an employee.  City taxes will only work if ComputerSearch 
has a deduction set up for it.  If a city tax is needed that is not currently in the table, call ComputerSearch 
Customer Service. 
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View Menu Options 

 
The View Menu Options controls which employees are displayed and in what order on the Time Sheet 
and Employee screens.  Default settings are controlled by your client setup with ComputerSearch.  
Contact ComputerSearch customer service if you wish your view defaults to be changed. 
 
The first option under the View menu is Group by.  Displayed employees may be grouped together by 
Department Number, Division or, Both.  If None is selected, the Sort by option determines the order in 
which employees are displayed. 
 
The next option is Sort By.  After determining how your employees should be grouped, Sort By will put 
them into the desired order.  Employees may be sorted by their Name or their Employee Number.  Also, 
Sort By offers an option to sort by Name ONLY or Employee Number ONLY; selecting one of these 
options will automatically turn Group By to None. 
 
Select determines which employees are displayed.  In the top part of Select you may choose from either 
Active, Terminated or, Both.  In the bottom part of Select, employees can be selected by their pay type: 
Salaried, Hourly, or Both. If Both is chosen as the selection criteria from both parts of the select menu 
(top and bottom), all employees will be displayed. Using the select option, it would be possible, for 
example, to display only the Terminated Hourly employees to ease looking for an employee to reinstate. 
Select also determines the employees to receive pay when using the Quick Pay feature. 
 
Auto Refresh will automatically update displays based on the new selection criteria and/or changes 
made to employee information.  To control when refresh occurs, turn off Auto Refresh.  Select the 
Refresh option when you want to have the display updated. 
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Employee Information Screen 
 
 
This is the Employee Information screen.  To access this screen, click the “Employee” button on the tool 
bar.  This screen allows you to Add New employees, View and Change employee information.  The 
following section will explain the various features of the Employee Information screen. 

 
 
When this screen is accessed the Select tab will be displayed. This area allows you to select individual 
employees. You may change the sorting and grouping methods for displaying employees from the View 
menu. See “View Options” above for more information on this subject. 
 
 
  

“Select Window”

Double Click on an

employee to select.

Name will then appear

above.

Selected Employee

Change Selected Employee

View will allow you to regroup or

resort the employee select window.

Press this button to display

Employee Information Screen.
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General Information 
 
 
This is the General Information screen for an employee.  Basic information such as Name and Social 
Security Number are entered here. To access this screen, click on the General tab.  Error checking for 
this screen is done when the data is saved, not as it is entered. 
 

 
 

Employee Number - This is a display only field.  Every employee must be assigned a unique number from 
1 to 9997. This number is assigned when a New employee is added and cannot be changed. 
 
Social Security Number - The employee's social security number may be viewed, entered or changed in 
this field.  
 
Last Name  - This field has a 20 character limit including spaces apostrophes and hyphens.  
 
First Name - This field has a 12 character limit including spaces apostrophes and hyphens.  
 
Middle Initial- Only one character may be entered in this optional field. 
 
CSC Name - This is how employee names will appear on reports and checks issued by ComputerSearch.  
This field has a 20 character limit (including spaces). Therefore it will be necessary to abbreviate first and 
middle names.  This field will be automatically updated any time a change is made to the other name 
fields; however the user may edit this field after it has been auto-updated. 
 
Sort Code - Sort Code is used to order employees on reports.  Normally it is the first five characters of an 
employee’s last name, i.e., Washington would have a Sort Code of WASHI.  If two employees have the 
same last name, you may wish to make the last character of the Sort Code the first letter of their first 
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name.  For example, John Smith and Steve Smith could have SMITJ and SMITS for their Sort Codes 
respectively.  Alternatively, Employee Numbers may be used for the Sort Code. 
 
Sex - Employee gender may be indicated in this field using either "F" or "M". 
 
Address Information - The Address, City, State, and Zip fields allow for maintaining employee home 
addresses. 
 
State Code - This field indicates which state this employee is earning their income in for tax purposes. 
See the Code Tables - State Codes for more information. 
 
Department Number -  This optional field shows the "home" department that this employee belongs to. 
This information is used in sorting and grouping employees for reports. 
 
W2 Pension - Enter an "X" to indicate that this employee is participating in a pension fund, which must be 
indicated on their W2 form. 
 
Hide Time Sheet Rate - You may choose whether an employee’s rate of pay is shown on the Time 
Sheets delivered from ComputerSearch.  If this box is checked, the employee’s rate will not be printed.   
 
Terminated - The Terminated Employee field is for display only, see Terminating an Employee later in this 
section. 
 
Employee Dates - There are three different dates available per employee:  Hire Date, Birth Date, and 
Term Date.  These dates are entered in MM/DD/YYYY format.  The date information can be typed into 
the box, or double clicking in the box will cause a calendar tool to appear. 
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Monetary 
 
The Monetary screen shows the items that determine how an employee receives their pay.  This includes 
the various rates of pay, pay type, and frequency.  Tax and direct deposit information are included on this 
screen, as well. 
 

 
 
Pay Rate - Fill in either the Hourly Rate or Salaried Rate fields as the Employee’s normal rate of pay.  An 
employee cannot have both.  The Hourly Rate has a maximum value of $9,999.999.  A Salaried Rate has 
a maximum value of $99,999.99.  Note that the Hourly Rate has three decimal places, whereas the 
Salaried Rate has only two. 
 
A Frequency, for how often an employee is paid, must be entered for each employee.  
Frequency codes are:  1 - Weekly 
    2 - Bi-Weekly 
    3 - Semi Monthly 
    4 - Monthly 
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Each employee also needs an Overtime Factor (also called Overtime Weight) to determine how their 
Overtime is computed.  Any factor from 00 through 99 can be used.  Example Overtime Factors:  
    00 - Non-Paid Time 
    05 - Half Time 
    10 - Straight Time 
    15 - Time and a Half 
    20 - Double Time 
    25 - Double Time and a Half 
    Etc. 
 
Exception Rate - Exception Rate (also called Second Rate) allows for paying an employee at two different 
rates of pay.  Exception Rate is always an Hourly Rate and has a maximum value of $99.999.  A 62-Entry 
Code with hours will pay an employee at his/her Exception Rate for those hours.  On a salary employee if 
he or she has Overtime hours and an Exception Rate, that employee will be paid at the Exception Rate 
times the Overtime Factor times the number of Overtime hours. 
 
Third Pay Rate - Third Pay Rate provides another option for paying an employee.  Third Pay Rate is an 
hourly rate with a maximum value of $999.999.  To use the Third Pay Rate, your payroll must be setup for 
this and a pay type dedicated for the Third Rate.  Contact ComputerSearch about this option. 
 
Federal Exemptions - Exemptions may be entered for both federal and state, however only federal is 
required. Note:  If an exemption is not entered for the State Exemption field, the Federal number is used.  
If no deductions from the Tax table are to be made, enter a 99 in the Exemption fields (State and/or 
Federal) for the effected tax, e.g., a person having a flat percentage withheld. 
 
Marital Status - Place either an M (Married) or S (Single) in the box for Marital Status. 
 
State Exemptions - Exemptions may be entered for both federal and state, however only federal is 
required 
 
Percentage of Sub Net (% of Sub Net) - Percentage of Sub Net will deduct a percentage from the 
Employee’s net after all taxes and other deductions.  The number entered will be treated as a percentage.  
Only whole percentages may be used, no fractional.  Valid entries are from 001 to 100.  The amount 
deducted will be placed in deduction 9 (Miscellaneous) on the Payroll Reports. 
 
Auto Tip Amount - Auto Tip Amount allows for an employee’s tips to be calculated on a rate per hour 
worked basis.  The rate entered here will be multiplied by the hours worked to compute the employee’s 
tips.  If an employee is setup for automatic tips and tips are entered on the time sheet, these two figures 
will be added. 
 
Additional Tax Withheld - Employees may have an additional amount of federal or state tax withheld from 
their check.  Enter the dollar amount of the desired additional withholding in the appropriate box(es) 
(Additional Federal Withheld box and/or Additional State Withheld box).  The maximum amount for 
additional tax is $9,999.99.  If an employee wants to have an additional percentage or flat percentage 
removed from his/her paycheck, check the “As a Percent” box next to the Additional Tax Withheld box.  
Enter, in the Withheld (State and/or Federal) box, the percentage needed, e.g., 10.50 would be ten and a 
half percent.  If this is to be a flat percentage (no amount from the Tax tables, just the percentage 
deducted) make sure to change the Federal Exemptions to 99 for that tax. 
 
Standard Other Earnings - Standard Other Earnings allows you to add an additional amount to an 
employee’s gross pay on a continual basis.  A dollar amount may be entered or using Standard Other 
Earning Codes (see below) it can be setup as a percentage or a rate.  When using the percentage or rate 
setup, you may wish to use Standard Other Earning Maximum to set the highest amount to be added 
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anytime.  The amount added by Standard Other Earnings is placed in the Other2 pay field.  The 
maximum amount for this field is $9,999.99. 
 
Standard Other Earnings Codes can make Standard Other Earnings a rate or percentage. 
 
 Codes:  
 1 - Percent of Regular Earnings    A - Only Week  1 
 2 - Percent of Regular + Overtime Earnings  B - Only Week  2 
 3 - Percent of Gross Pay    C - Only Week  3 
 4 - Rate x Regular Hours    D - Only Week  4 
 5 - Rate x Regular and Overtime Hours 
 
Standard Other Earnings Maximum - Sets the maximum Standard Other Earnings to be added to the 
gross pay. 
 
No FICA - If an employee is exempt from paying FICA place an ‘X’ in this field.  Note: An employee 
cannot be changed from FICA Exempt to FICA Taxable midyear.  Another new employee must be 
created for him/her.  A 1099 employee would be setup for No FICA and would also have a special DBL 
Code of 9. 
 
City Code - This code is used to indicate that this employee must have a local city tax deducted from their 
wages.  See Code Tables - City Codes for more information. 
 
Disability Insurance (DBL) Code - DBL Codes allows employees to be setup as exempt from NYS 
disability, State Unemployment Insurance (SUI), or Federal Unemployment Tax (FUTA). 
 
The DBL Codes:  X - No Disability, Take SUI and FUTA 
    2 - Take Disability, No SUI or FUTA 
    3 - No Disability, SUI, or FUTA 
    9 - 1099 Employee - No Disability, SUI, or FUTA * 
 
If left blank DBL, SUI, and FUTA are taken normally.  * Remember for a 1099 employee he or she also 
needs to be setup for No FICA.  Place code X in the No FICA Box. 
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Banking  
 

Direct Deposit 
 
The Bank section is used to set up an employee for direct deposit if your client master file has also been 
setup for direct deposit.  If your payroll needs to be setup for direct deposit, please contact 
ComputerSearch. 
 
 
 

 
 
 
                     Edit banks button        Add a Bank button 
 
 
 

How to Setup Direct Deposit 
 
Every time a new direct deposit account is created for an employee it must first go through a 
prenotification (prenote) cycle.  This takes 10 banking days.  If there is a problem with the account setup, 
the bank will contact you about the problem during this period.   
 
To setup an employee for the prenotification cycle, press the 'Edit Banks" button on the employee's 
Monetary tab then press the 'Add a Bank' button.  Start by entering the Bank Code, which is the two 
character code for the Employee’s bank.  You may alternatively enter the transit routing number here, or 
press the Find… button next to the bank code. 
 
 
Choose (C)hecking/(S)avings.  Note: If an employee can write a check against this account, it is 
considered a checking account. 
 
Choose either Net or a deduction number and amount.  You may use the Find…button to view and 
choose the deduction.  A deduction amount may be set up at this time.   
 
When the prenotification time passes the deduction or the net pay amount will be deposited into the 
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employee's bank account at that time.  You will see the effective date after the payroll runs and after you 
have received your current Micromaster. 
 
Lastly enter the Employee’s bank Account Number in the Bank Account field. 
 
If the Bank reports a problem to you on the prenotification, You must delete the bank using the delete 
option and add the corrected bank information starting the prenotification process over again. 
 
If there are no problems after 10 banking days, the net pay or the deduction amount will be used as the 
deposit amount.  If everything was set up correctly you will not need to do anything for this to take place. 
 
If, in the future, you need to change the bank or the account number you must delete the bank entry and 
start a new bank entry and of course go through the prenote period. 
 
You may change the checking or savings option and also change the net pay to a deduction (you may 
only have one bank entry setup as net pay) or the deduction amount without going through the prenote 
period. 
 
 
 
 

Monetary Screen after payroll runs  
 

 
 
                      Note: Money Source and Effective Date 
 
 
 
 
 
 
 

Holding a bank for one payroll 
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Note: Hold option available for NET PAY type deposits 
 
Should a direct deposit need to be stopped for one pay period, thereby cutting an employee a “live 
check,” use the 'Hold' option.  This option is used only with Net (N) checks, i.e., Net Pay Deposit.  Note: 
This is not a permanent change; the hold is only active for that pay period.  After the Micro Master has 
been downloaded and a new payroll started, the bank will revert to the NET PAY deposit. 
 

Holding a bank with a deduction as the money source 
 
If deductions need to be stopped for that check, go to the Deductions area on the Time Sheet screen, 
enter the Deduction number in the Ded No field, zero for the amount in the Amount field and select “Omit” 
in the Force/Omit field.  If the Direct Deposit check has a direct deposit deduction, e.g., the check is split 
between checking and savings accounts, go to the Deductions tab on the Employee Information screen 
and place zeroes in the Amount field to stop that deduction.  Note: The Deduction amount will need to be 
re-entered for the following payroll. 
 

Deleting a Direct Deposit 

 

Simply choose the Delete button on the Edit Banks Screen and check mark the bank you wish to 

delete.  An asterisk will appear on the monetary screen where the bank code was. 
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 Deductions 

 
The Deductions screen can be used to Start, Stop, or Change an employee’s deduction Amount, Type, 
Week, and Balance. 
 

 
 

Deduction Type 
 
To setup deductions that are not a simple dollar amount, the Deduction Type will need to be used.  The 
different codes available allow for many ways to set a deduction’s amount.  For example, when using a 
Fractional Percentage Deduction code (7 or F), entering 9.25 in the amount field will cause 9.25% to be 
deducted. 
 

Deduction Type Codes:  

1 - Percent of Regular Earnings 
2 - Percent of Regular + Overtime Earnings 
4 - Rate x Regular Hours 
5 - Rate x Regular and Overtime Hours 
6 - Rate x Regular + Rate x (Overtime Hours x Overtime Factor) 
7 - Fractional Percentage of Gross 
A - Deducts a flat amount and maintains an arrearage balance 
B - Percentage of Net Pay after taxes and other deductions, only one B code deduction allowed 
D - % of Disposable Income - Child Support 
F - Fractional Percentage of Regular, Overtime, and Other1 Earnings 
L - Tax Levy 
M - Maximum Net Pay 
N - Net Pay 
R - % of disposable income - Higher Education Loan, Garnishment 
S - Substitute Tax Levy 
 

Deduction types may be set up on the Client Master file.  Therefore, all employees with that deduction 
have the type automatically set, i.e., 401-K deductions that are all Percentage of the Gross. 
 
Other more specialized types are available for garnishes and other special situations.  Please contact 
ComputerSearch for more information. 
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Deduction Week  
 
A number entered in the Deduction Week field will cause this deduction to be deducted on that particular 
week ONLY.  Valid week numbers are 1, 2, 3, and 4.   
 
The “L” Deduction Week code may be entered in the week field.  This will cause the deduction to be 
taken every week except week 5 on a weekly payroll and every week except week 3 on a biweekly 
payroll.  The “M” Deduction Week code will take a deduction on the last week of a month.  
 
Other Deduction Week Codes: 
 
 A - Week 1 & 2  D - Week 2 & 3 
 B - Week 1 & 3  E - Week 2 & 4 
 C - Week 1 & 4  F - Week 3 & 4 
 G - Weeks 1 & 2 & 3 
 
Under normal situations, deductions that are for a particular week should be coded on the Client Master.  
This will control the week of that deduction for all employees. 
 
 

Deduction Amount 
 
The maximum amounts for deductions in the Deduction Amount field are: 
 
 Deductions 1 - 8 is $99,999.99 
 Deductions 11 - 49 is $9,999.99 
 

Stopping Deduction 
 
Entering zero in the Deduction Amount field will stop the deduction for an employee. 
 

Deduction Balance 
 
The amount of the deduction is subtracted from the Balance, per pay period.  If the Balance is lower than 
the amount of the deduction, then just the remaining balance is taken.  Once a deduction Balance 
reaches zero the deduction is automatically stopped.  The maximum amount for a Balance field are 
Deductions 1 - 18 is $99,999.99 
Deductions 21 - 49 is $9,999.99 
 

Quarter To Date / Year To Date 
 
The last two columns on the deductions screen display the Quarter and Year to date totals of each 
deduction for the selected employee. 
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Earnings 
 

 
 
The Earnings screen displays the Quarter-To-Date (QTD) and Year-To-Date (YTD) pay information for 
the selected employee.  This information includes: Gross, FICA, Federal Withheld, State Withheld, 
Disability, OASDI (Social Security), Medicare, City, Tips, Meals, Tips Over Minimum (Tips Over Min),  
Allocated Tips (Alloc Tips),  3rd Party Sick Pay Gross (3rd Party GR), 3rd Party Sick Pay FICA (3rd Party 
FICA), 3rd Party Sick Pay Nontaxable Gross (3rd Party NonTx GR), 3rd Party Sick Pay Federal Withheld 
(3rd Fed Withheld, 3rd Party Sick Pay State Withheld (3rd State Withheld), Month-To-Date Gross (MTD 
Gross), Tax Shelter Annuity (TSA),  Federal Unemployment Tax (FUTA), State Unemployment Insurance 
(SUI) and FICA Taxable (FICA Txbl). 
 
To access the Earnings screen click the Employee Information button on the toolbar or go to the Edit 
menu, select the Employee option (Ctrl + E), and then click on the Earnings tab.  Note: The information 
displayed on this screen is not editable. 
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Accruals 
 

 
 
The following employee information can be viewed on the Accruals screen: Pay Type, Balance Hours, 
YTD and QTD Taken Hours, YTD and QTD Gross, and if used, the codes for accumulating these hours.  
To access the Accruals screen click the Employee Information button on the toolbar or go to the Edit 
menu, select the Employee option (Ctrl + E) and then click the Accruals tab. 
 
Pay Type - A description of your Pay type is displayed at the bottom of the screen. Pay type, may be 
Regular, Vacation, Sick, etc.  
  
Cycle Code - Cycle codes determine how often an employee receives his/her allowed hours for a Pay 
type.  The codes: 
 
 1, 2, 3, 4 - Yearly at the end of this quarter 
 5  - Accrues annually based on HR Date 1 
 6  - Accrues annually based on HR Date 2 
 7  - Accrues annually based on HR Date 3 
 8  - Accrues annually based on HR Date 4 
 9  - Accrues annually based on HR Date 5 
 
 A - Percentage of All Regular Hours Worked - Only Entry Codes 61 & 62 
 M - Monthly - On the first pay of the following month for previous month accrual 
    ( continued ) 
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 P - Percentage of Hours Worked - All Regular Hours any Entry Code 
 Q - Quarterly 
 V - Percentage of all hours (Regular and Overtime) all pay types 
 W - Weekly 
 Y - Yearly based on Hire Date 
 Z - Yearly based on Hire Date.  Writes over balance, no carry over. 

X - Yearly based on Hire Date.  Writes over balance, no carry over UNLESS negative then    
subtracts Negative balance from new balance. 

 
 
Max Bal - Maximum number of hours an employee can have in his balance.  Will not accrue any 
additional hours until balance is below Max Balance. 
 
YTD Accrued - Number of hours accrued this year. 
 
Max YTD Accru - Maximum number of hours an employee can accrue in a year. 
 
Allowed Hours - Allowed Hours are the number of hours an employee will accumulate for a specific pay 
type at the end of the cycle as defined by the Cycle Code.  This may also be the percentage of hours to 
accumulate for a pay type. 
 
Balance - Remaining hours for that pay type.  The balance is setup by the client for their employees.  The 
amount shown reflects a declining balance. 
 
QTD Taken - Hours taken within that quarter for that pay type. 
 
YTD Taken - Hours taken to date for that pay type. 
 
QTD Gross - Dollars earned within that quarter for that pay type. 
 
YTD Gross - Dollars earned to date for that pay type. 
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Personnel 
 
The Personnel screen has fields for: personnel data, number of weeks worked, and various employee 
date information. 
 

 
 
Personnel Fields - There are twelve personnel fields available in Micropay for your use.  These fields may 
be filled with any alphanumeric data.  Sizes for the personnel fields:   
  Fields 1-3 10 characters 
  Fields 4-10 4 characters 
  Fields 11-12 6 characters 
 
Titles can be entered for Personnel fields.  Contact ComputerSearch Customer Service for more details. 
 
Memo Employee Number - Memo Employee Number will hold seven characters that are alphanumeric.  
The Employee’s phone number is typically placed in this field; however, any entry may be placed here. 
 
Weeks Worked - The number of weeks worked by this employee. 
 
Last Week Worked - The last week number during the year this employee received pay.  The week 
number starts at the beginning of the year with 1 and counts until the end of that year. 
 
Weeks Worked QTD - The number of weeks this employee was paid during that quarter. 
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Weeks Worked YTD - Reflects the number of weeks an employee was paid during that year. 
 
# Wkd Under - This field is obsolete, but has been retained to maintain compatibility with historical data. 
 
EIC Code - The Earned Income Credit (EIC) code must be set up by ComputerSearch before it can be 
used, to do this call customer support at (716) 689-0511. This code refers to the status of employees who 
file for EIC on their tax returns. The valid codes which may be entered in this field are: 
 1 = Single or Head of Household 
 2 = Married, both filing for EIC. 
  3 = Married without spouse filing 
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Human Resources (HR) 
 
The HR screen has fields for human resources related data, title, phone number, e-mail address, ID 
photo etc. These fields are not used in payroll processing; they are for your records only. All data entered 
on this page will be transmitted to ComputerSearch for storage. 
 

 
 
 
Browse for Picture - An Employee ID photo may be displayed on this page. Any JPEG (JPG) or Bitmap 
(BMP) file may be displayed. The Browse for picture button allows you to create a link to an existing 
image anywhere on you local or network disks. This feature may be used to add new images or change 
existing image links. Images may be displayed in either portrait or landscape orientation by selecting the 
appropriate radio button. 
 
Delete Link to Picture - This feature allows you to remove an existing image file link; it does NOT delete 
the image file itself. 
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Employee Title - The title field is a text field to provide you with a means for classifying employees. 
 
Employee Status - This is an editable, single character data field provided as an option for your records. 
 
Employee Email - A text data field has been provided for you to record a single email address for each 
employee. 
 
Employee Phone - You may record one phone number per employee in this field. 
 
Phone Ext. - This field is useful for keeping track of in-house phone extensions. An employee directory 
report can be generated from this data using the CS Reports program. 
 
Next Review Date - Performance/salary review dates may be tracked in this field. If you wish this data to 
appear in the date alarm section of the time sheet header page the box next to the data field must be 
checked for each employee. This field MUST be updated manually. 
 
Several fields are available to record individual emergency contact information. CS Reports may be used 
to generate an emergency contact directory using this information. 
Emergency Contact Name- This text field allows you to record the name of an individual to be contacted 
in case of emergency. 
 
Contact Phone- The phone number for the emergency contact may be stored and edited in this field. 
 
Contact Relation- It is often necessary to know the relation of an emergency contact to the employee. 
This information may be stored here. 
 
Termination Reason - An editable text field is provided for recording termination information. 
 
Last Worked Date - This date field is not automatically populated, but is provided as an option for your 
record keeping. 
 
Rate Change history is a new section that is automatically populated each time a change is made to an 
employee's rate of pay. 
Last Change - The date of each rate change is recorded in this editable field 
 
Salary - Changes in the salaried rate of pay will cause the new salary rate to be displayed here. 
 
Hourly - Changes in the hourly rate of pay will cause the new hourly rate to be displayed in this column. 
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HR2 
 
The HR2 screen has fields for additional user defined human resources related data including COBRA 
insurance information. These fields are not used in payroll processing; they are for your records only. All 
data entered on this page will be transmitted to ComputerSearch for storage along with your payroll data. 
 
 

 
 
 
Cobra Notified Date  - Enter the date of the employee is notified of COBRA eligibility; this date is NOT 
available in the data alarm list on the timesheet header page. 
 
Cobra Election - Click on the check box to indicate that the employee has elected to use Cobra benefits. 
 
Cobra Effect Date  - Enter the date that COBRA benefits went into effect, this date is NOT available in the 
data alarm list on the timesheet header page. 
 
Cobra Term Date  - Enter the date on which the COBRA benefits will terminate. This date WILL be 
displayed in the data alarm list on the timesheet header page if the checkbox to the right of the field is 
checked. 
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File Attachments -  
Browse/View - Any document on you local or network disks may be associated with and employee. This 
feature may be used to keep track of letters of commendation, reprimand, or other special recognition. 
Once a file has been selected the time that the file was added and the full path specification to the file are 
displayed in editable fields. After selecting the file, the Browse button changes to View and the Files may 
be viewed in the default application by clicking on the button. 
 
Delete - This feature allows you to remove an existing file link, it does NOT delete the file itself. 
 
 

 
Adding a New Employee 

 
To add a new employee, click the Employee Information button, then from the Edit menu select Add 
Employee.  The General Information screen will be displayed and the next available employee number 
will be generated.  The Employee number may be changed to any available number from 1 to 9997; 
simply type the new number and that number will appear in the Employee number field.  Note: Once the 
Employee has been saved the Employee Number cannot be changed.  If an employee has been 
terminated, their employee number can be reused after ONE CALENDAR YEAR.  For example, an 
employee terminated in March 1999, their number can be used again in January 2000.  If an employee is 
terminated and then is rehired, their previous employee number may be reused, simply pay the 
terminated employee and they will be reactivated.  Note: This must be done in the same year. Terminated 
employees are dropped from Micropay at the end of the year. 
  
Now enter the rest of the information for the Employee on this screen and any others as necessary.  The 
following is the minimum information necessary for a new employee: Name, State Code, Sort Code, Rate 
of Pay, Federal Exemptions, Marital Status and Department Number.  This information is contained on 
the General or Monetary screens as follows: 
 
 
 General Information Screen  Monetary Information Screen 
 
 Name Rate (Hourly or Salary) 
 State Code Federal Exemptions 
 Department Number Marital Status 
 Sort Code  
 
 
Once all your information has been entered, be sure to save the changes by clicking the “Save” button or 
select Save Employee under the Edit menu.  To abort adding a new employee, select Cancel Employee 
from the Edit menu.  This must be done before saving or else you cannot abort adding a new 
employee.  Note: Once an employee has been added the entry cannot be deleted. 
 
 

Changing an Employee 

 
To make a permanent change to an employee, find the field you need to change, then click in that field 
and type the new or correct information.  Once finished save your changes by clicking the “Save” button 
or from the Edit menu select Save Employee.  If you decide you do not wish to make these changes, go 
to the Edit menu and select Cancel Employee, this will undo your changes since your last save to this 
employee.  
 
 
 

Terminating/Inactivating an Employee 
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Terminating an employee is done from the Time Sheet screen.  To terminate an employee use an entry-
code of 19 in the Entry field on their time sheet, then save the employee. Alternatively, using an entry 
code of 1I causes the employee to be marked as "inactive". Inactive employees are handled exactly the 
same as terminated employees in every way, except that they are NOT removed from your employee 
database at the end of the year.  Now a small window will appear asking for a termination date.  You may 
enter a date or accept the date already in the window, which is the week ending date for the current 
payroll.  The terminated box on the General Information screen will now be checked and the date entered 
will appear in the Terminated Date on that screen as well.  Note: If the Select option from the View menu 
is not set to either “Both” (Active and Terminated) or “Terminated,” the terminated employee will not be 
displayed. 
 
To reactivate an employee, change the view to show terminated employees and then on the Time Sheet 
screen make an entry for that employee with any entry code other than 19 or 1I.   
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Cancel Employee 

 
Cancel Employee will undo changes made to an employee since the last time they were saved. 
Employee information is restored to the settings before the last save.  If you Cancel while adding a new 
employee and before saving, that employee will be aborted. 
 

 
 
Cancel button 
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Time Sheet Area 
 

The Time Sheet area contains tabs for displaying and editing data for the Time Sheet Header, individual 
Time Sheets, and Preissued Checks. 
 
 

Time Sheet Header 
 
The Time Sheet Header must be completed before any changes or additions can be made to the payroll.  
If the payroll has been transmitted, a “New” button appears on the Header screen.  Click the “New” button 
to start a new payroll. 
 

 
 
All fields at the top of this page except the Next Check Date must be filled out. Double clicking the mouse 
in any date field will bring up a calendar tool.  Once the Time Sheet Header has been filled out, click on 
the “Save” button. 
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Time Sheet Header Fields: 
 
The Status box will display “Not Validated.”  Once the payroll information has been entered and validated, 
the display will change to “Validated.”  After transmitting the payroll to ComputerSearch, the Status 
changes to “Transmitted.” 
 
Week Ending Date - The date the pay period ends. 
 
Check Date - The date checks are to be dated. 
 
Starting Check Number - Enter the number for the next check or enter “1".  If “1” is used, the next number 
in order will be used to date the check. 
 
Next Check Date - (Optional) The Check Date of the next payroll expected to run. 
 
Week Number - This indicates the Week of the month, based on check date, for the current payroll. Valid 
values are 1-5 for weekly payrolls and 1-3 for biweekly payrolls. 
 
Reset MTD - Resets the department summary report for the month.  Normally done on week 1 of the 
month.  This field is a ”check box” and will reset MTD totals when the box is checked. 
 
Stop ALL NET PAY Direct Deposits - this check box allows you to stop the direct deposits for this payroll. 
 
 

HR Date Alarm List: 
 
Several dates from the Employee Information HR and HR2 tabs can be used to trigger alarms shown in 
the display list at the bottom center of the Time Sheet Header page.  To make use of this feature you 
must enter date values in an alarm capable date field (Review Date, Cobra Termination Date, HR Date 1 
to 5) AND click on the check box next to the field for each employee. None of these date fields are 
automatically updated so that you may look for past dates to determine if one has been overlooked. 
 
Date Range - There are two sections under the date range title. The top portion allows the user to select 
one of four options: 

Ignore Date Flags - basically turns off the alarm system, all flagged dates are ignored. 
Ahead - displays names of all employees with flagged dates occurring in the next 30, 

60 or 90 days 

Past - displays names of all employees with flagged dates having occurred in the 

past 30, 60 or 90 days 

Both - displays names of all employees with flagged dates having occurred in both 

the past and the upcoming 30, 60 or 90 day 
The second portion permits the user to specify how long the date alarm range should be, 30 60 or 90 
days. 
 
Any flagged dates that fall within the specified date range will cause a title (i.e. Review Date) to appear in 
the display list. The title line is followed by the names of all employees having, in this case, a review date 
with in the specified date range. 
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Time Sheet 

 
The Time Sheet screen is where most pay entries will be made for employees.  In the lower right corner 
of the screen is an information box.  This box displays important pay information for the selected 
employee; the information in the box cannot be edited.  Also on the Time Sheet is the Quick Pay button.  
Quick Pay is an easy way to pay all hourly or salaried employees (see Quick Pay section for more 
details).  Common functions are available from the Tool Bar on the Time Sheet screen (see Keystrokes 
and Buttons section for more details).  In the View Timesheet Entries section you can select between 
viewing One Employee or All Employees.  The All Employee view mode allows you to browse through all 
of your payroll entries, but data cannot be entered in this mode. The One Employee view mode must be 
used to enter payroll data. 
 

 
 

Quick Pay ButtonSelected EmployeeView

Selected Employee’s Information
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Using the Time Sheet Screen 

 
This is a general explanation of how to create a pay entry. 
 

Selecting an Employee 
 
First, select the employee for whom an entry will be made. To do this: move the highlight bar to the 
desired employee and press Enter or place the mouse pointer over the desired employee and double 
click the left, mouse button.  Once an employee has been selected the cursor will move to the entry code 
box and the name of the employee will appear in the title bar. 
 
Type the Entry Code and press Return.  Fill the other fields as necessary.  To pay a salaried employee 
their standard salary only the entry code is needed. 

 
If additional lines are needed for an employee, press the Down Arrow or Enter at the end of the line 
(column labeled OT).  To access the Deduction area, click in the Deduction number box or press Alt-D.  
Enter the Deduction number, the amount and the Entry Code for the deduction.  Note: By clicking in the 
Deduction number box, then clicking the right, mouse button, the Client Deductions window will be 
displayed. Double clicking on an entry in the Client Deductions window will cause that deduction code to 
be entered with the pay code from the first timesheet line for this employee. 
 

 

Employee being Paid

Employee Selection Window
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Deduction Overrides 
 
To enter the Deductions area on the Time Sheet screen, click in the Deduction number box or press Alt-
D.  Enter the number for the deduction to override.  Pressing F4 or clicking the right mouse button will 
bring up the Client Deductions window that has a list of your deductions.  If a specific amount is needed, 
type it in the Amount box, then press Return.  The cursor will now be in the Entry box.  Here the Entry 
Code is entered for the deduction.  If an employee has more than one check, this tells the computer from 
which check to take the deduction. 
 

 
The last box is the Force/Omit box.  To stop a regular deduction from a particular check, select Omit here 
by clicking the down arrow and choose Omit from the list.  If a standard deduction is to be deducted from 
a check that it would normally not (such as an 81 check), select Force here.  When using Force/Omit an 
amount need not be entered. 
 
To omit all deductions (except taxes) on a check use deduction number 99 and the Force/Omit box will 
show Omit All.  This will stop all voluntary deductions. 
 

Deduction numbers for various taxes: 
 

55 - Social Security - Never change or else it may create an “Out of Balance” with your “941" 
on your quarterly reports.  Call ComputerSearch for more information. 

56 - Medicare 
52 - Federal Tax 
53 - State Tax 
54 - Disability 

 

Regular

Pay

Vacation

Pay

Deduction

Overrides
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Time Sheet Fields 
 
Entry Codes (Entry): 
 
 61 - Regular Pay 
 62 - Second Rate 
 63 - Holiday Pay 
 64 - Jury Pay 
 65 - Sick Pay 
 66 - Vacation Pay 
 67, 68, 69 - Defined by the Client 
 
All Sixty series entry codes combine onto one check.  Alpha entry codes act the same as the Sixty series, 
each letter representing a separate check, i.e., A1=61, A5=65, B1=61, etc. 
 
7X - Single line Regular Check 
Seventy series’ checks do not combine as a single check.   71 and 72 checks are two separate checks; 
both at the employee’s regular rate of pay, and will take all scheduled deductions. 
 
8X - Bonus Check     
Eighty series’ checks only take dollar amounts from the Other-1 and Other-2 fields.  Taxes are the only 
deductions taken unless a deduction is forced or a deduction override is entered. 
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9X - Separate Vacation Check 
Ninety series’ checks are each for a separate check for vacation with X being the week of the month for 
which the check is being issued.  If deductions are setup to come out on a specific week, a vacation 
check with that week (as the second digit) will have that deduction. 
 
Regular Hours (Reg Hrs): All hours entered here will be taken at straight time, multiplied by the First (61) 
or Second (62) rate depending on the Entry Code.  Note: If a Temporary Rate is entered, this will override 
the Employee’s normal rate.  Hours entered for a salaried employee are for recording purposes only; they 
will not affect the salary.  Maximum value for a Regular Hours entry is 999.99. 
 
Overtime Hours (OT Hrs):  All hours entered here will be calculated at the Overtime Factor.  For a 
salaried employee if he/she has an exception rate this times the Overtime Factor will be used for this 
calculation.  Maximum value for an Overtime Hour entry is 999.99. 
 
Other 1 - Entries here will be added to the gross as dollar amounts.  The Eighty series’ checks only look 
here for a dollar amount to figure the gross.  The maximum dollar amount for an Other-1 entry is 
$999,999.99. 
 
Other 2 - Entries here are also added to the gross as dollar amounts.  For restaurant payrolls, the dollar 
value of tax-exempt meals is entered here.  The maximum dollar amount for an Other-2 entry is 
$999,999.99. 
 
Department Override (Dept OR): This field is used to assign part of an employee’s earnings to a 
department other than his/her home department.  Enter the desired department number for the override. 
 
Temporary Rate (Hr. Rate or Salary fields):  Use these fields to pay an employee a different rate instead 
of the normal rate.  Enter the amount in the appropriate field, e.g., for an hourly employee, place the 
amount in the Hourly Rate (Hr. Rate) field or for a salary employee, place the amount in the Salary Rate 
(Salary) field.  The Hourly Rate field has a three decimal place limit and a maximum value of 9,999.999.  
The Salary Rate field has a two decimal place limit and a maximum value of 99,999.99.  Note: DO NOT 
enter dollar signs in these fields. 
 
FR - A temporary override of the frequency code for that check only.  This will change the tax calculations 
to the following: 
 
  1 - Weekly 
  2 - Bi-Weekly 
  3 - Semi Monthly 
  4 - Monthly 
  9 - Maximum Federal and State tax rates 
 
Overtime (OT) - A temporary override of the Overtime Factor just for that check.  The codes are: 
 
  00 - Non-Paid Time 
  05 - Half Time 
  10 - Straight Time 
  15 - Time and a Half 
  20 - Double Time 
  25 - Double Time and a Half 
 
Job Number (Job No):  Job number for this pay line.  This information is used on the optional Payroll Job 
Distribution report.  Contact ComputerSearch for information on setting up this report.  Note: This feature 
is disabled by default (see the Time Sheet Tab section to enable this feature).  Any numeric values may 
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be used for the Job Number.  Note: if the Job Number is to be used to track commercial work, such as 
construction jobs, place the letter “c” in front of the job number.  For further information contact 
ComputerSearch.  
 

Deleting Entries 
 
Entries may be deleted, on the Time Sheet screen, one line at a time or all entries at once, for an 
employee.  The “Delete” button found on the screen will delete the current line.  The Delete Time Sheet 
command under the Edit menu will delete all entries, i.e., multiple lines, for an employee. 

 
 
Keystroke and Button Shortcuts for the Time Sheet  

 
There are some special keystrokes and buttons designed to make the Time Sheet screen easier to use. 
 

Keystroke Shortcuts: 
 
Tab or Enter keys - After entering a value in the Entry Code field, pressing the Enter or Tab key will 
advance the cursor to the next field and generate a new line.  
 
Arrow Keys - The Up/Down arrow keys will move the cursor between lines.  The Left/Right arrow keys will 
move the cursor within a field. 
 
/ - Pressing the slash key will save the current employee’s data and move the highlight bar to the next 
employee in the list box.  
 
Alt-D - Moves the cursor to the Deductions area at the lower left of the screen; it places the cursor in the 

Delete all entries for

an employee
Delete one line
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Deduction Number box. 
 
F2 - Clear a field. 
F4 or Right Mouse Button - Brings up a pop-up menu of choices where available. 
F5 - On time sheet is the same as pushing the regular hours button. 
F8 - On time sheet is the same as pushing the holiday hours button. 
 
Shift-F1 - Sorts employees by number. 
Shift-F2 - Sorts employees by name. 
 
Esc - Will clear a recently entered value in a field or if the value has been changed it will return the field to 
its previous value. 
 

Button Shortcuts: 
 
Delete Button - Deletes current line only. 
View Timesheet Entries - “One” is used for data entry.  “All” is for viewing entries only. 
 

 
- The Quick Pay button will pay several employees, if they receive identical pay entries. 

 
- Expands or shrinks the Employee Select Window. 

 
- Issues standard regular hours.  

 
- Gives an employee regular and holiday hours. 

 
Note: The number and type of hours given by the regular and holiday functions are setup on the 
Preference screen (select the Toolbar tab). 

 
- Saves the current employee’s entries and highlights the next employee. 

 
- Saves the current employee’s entries.  The same as “Save” button at right of the screen. 

 
Quick Pay 

 
The “Quick Pay” button will pay several employees at once.  Note: All employees must receive the same 
pay entry or the Quick Pay feature cannot be used.   Quick Pay may be used to pay Hourly, Salary or 
Both pay types.  
 
Note: If Quick Pay is used to pay both Salary and Hourly employees together (as opposed to using Quick 
Pay to pay them separately), an Hourly employee will need to be selected as the base, pay entry.  This 
will place hours in the Regular Hours field and ensure Hourly employees will receive a paycheck.  Hourly 
employees’ pay is calculated by using the number of hours entered in the Hours Field.  Therefore, having 
hours in the Hours field is essential.  Normally Salary employees do not have hours placed in the Hours 
Field.  Having hours placed in the Hours Field will not affect Salary employees with this method. 
 
When using Quick Pay to pay just Salaried or just Hourly employees, use the Select option under the 
View menu to have the Employee window display only Salaried or Hourly employees (see View Options 
for more information).  Make a base, pay entry: select one employee and make a pay entry for him/her 
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and then save this entry.  When the “Quick Pay” button is clicked, a reminder message will be displayed 
asking whether the employee type (Salary, Hourly or Both) has been selected and if a pay entry has been 
made.  If this has been done, click “Yes.”  If not, click “No”.  Then go and select the employee type the 
base pay entry will be made for and make the entry.  Note: This message is a reminder and will always be 
displayed when the “Quick Pay” button is clicked. 
 

 
 

Next the Quick Pay list box will be displayed with the employee types (Salary, Hourly or Both) selected. 
 

 
 
Now you can select the rest of the employees you want to pay.  If all of the employees listed are to be 
paid, click the “Mark All” button.  All the employees will be highlighted.  To select individual employees to 
pay, hold down the Ctrl key and then click on each employee; clicking on an employee that is already 
highlighted will deselect them.  To highlight a contiguous block of employees click on the first employee in 
the range, then hold down the Shift key and click on the last employee in the range.  After the employees 
have been selected, click the “Ok Pay’em” button.  A warning message will appear informing you that this 
action will overwrite previous pay entries made for these employees.   
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If this is a regular pay entry, then click “Yes.”  If these entries are to be added to any pay entries they 
already have, the “Add Checks To Existing Entries” option must be checked first.  Otherwise, the Quick 
Pay Entries will overwrite any existing entries.  
 

 
 
After Quick Pay has completed paying the employees, it will display the number of employees paid in the 
status line, at the bottom, of the Quick Pay list box.  Click the “Exit” button to return to the Time Sheet 
screen. 
 
The “Delete Entries” button will delete ALL entries for any selected employees.  Use with CAUTION. 
 
 
 

Hints & Tips 
 
-To pay a salaried employee the only entry needed is an entry code. 
 
-A salaried employee who receives more than one sixty-series entry will need to have zeroes entered in 
the Temp Rate for each line other than the first.  Lines that are not zeroed out, i.e., have zeroes in the 
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Temp Rate; will pay the employee his/her salary AGAIN. 
 
-On a seventy-series check (separate check) for a salaried employee, if an employee is not to receive 
his/her regular salary, zeroes or an override salary needs to be entered in the Temp Rate for that 
employee. 
 
-An eighty-series check (separate bonus check) will only take amounts toward the gross from the Other1 
(dollar amount) field.  Only taxes and DBL will be taken.  The DBL deduction (#54) will more than likely 
need to be zeroed out and if the employee wants any voluntary deductions, such as 401-K, you must 
“force” that deduction to be taken (Deduction number plus a minus (“-“) sign). 
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Accrual Balance Checking 
Labor Code Timesheet Field 

& 
Certified Payroll Input 

 

 
Turn these options on at the preference screen for the timesheet.   
 
Turn on the accrual checking here and its various options.   The labor code filed will appear on 
the timesheet when this is checked.  The certified payroll input option is here.  They will all be 
off by default. 
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Accrual Balance checking 
& 

Labor Code Field 

 

 

Upon entering an accrued pay type, if the balance will go to zero or less a message will appear 

here and if you had selected in the preferences a popup message may appear.   

 

Also note the ten character Labor Code field at the end of the row here.  
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Certified Payroll Input 

 
Put an initial entry code on the pay line.  Right mouse click on that lines job number field.  This screen will 
pop up. 

 

 

You may enter the hours by day.  The timesheet will be filled out like the 

following: 

 

 

 

 

You may make changes as needed or cancel the whole time sheet and start over.  
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Preissued Checks 
 
Preissues update an employee’s information without producing an actual check.  Both Regular and Third 
Party Sick pay Preissues are entered on this screen.  The method for doing each is different. 
 

 
 
An employee is allowed up to five “In” and five “Out” regular preissues.  Each employee may have one “In 
Preissue” that prints a live check.  This feature is useful if you want a check to come out in a very specific 
way.  This preissue is in addition to the maximum five “In Preissues.”  For Third Party Sick Pay an 
employee may have one “In” and one “Out” preissue for taxable and one “In” and one “Out” for non-
taxable amounts.  “Out Preissues” do not need to be entered with negative numbers; this is handled 
automatically.  A negative number on an “Out Preissue” will be treated as a positive. 
 
On regular preissues the gross pay will be calculated from the line items entered.  Then any deductions 
and/or taxes plus the net pay will need to be entered.  These calculations will be checked when the 
preissue is saved and if it does not crossfoot; a message will appear along with the Net that would 
crossfoot.  Make the necessary adjustments and save again. 
 
Keystrokes and Employee selection function the same for Preissues as they do for the Time Sheet.  The 
special toolbar buttons for the Time Sheet are, however, not available. 
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Regular Preissues  
 
The first step to enter a preissue is to select an employee.  If this employee already has any preissues, 
they will show up in the Entered Preissues box.  To edit one of these preissues double click on it and the 
information will be brought up.  If the employee does not have any preissues, the screen will be brought 
up ready for a new preissue.  Otherwise, to add a new preissue, click the “New Preissue” button. 
 
To enter a new preissue, determine whether this is an IN (add to totals) or an OUT (subtracts from totals) 
preissue, then select the “IN” or “OUT” button under Preissue Type, in the upper left corner of the screen.  
If this preissue is to cut a live check, select the “Print A Check” option.  Now click in the Pay Type box to 
start entering your Preissue Line Items for the preissue. All entries for a preissue need a Pay Type, 
otherwise only the fields you need should be filled.  Amounts placed in Regular Pay, Overtime Pay, Other 
1, and Other 2 fields will add to the gross. 
 
After all your Preissue Line Items have been entered, enter any deductions as necessary.  To access the 
Deduction area, click in the Deduction area or press Alt-D.  Enter the Deduction Number and Amount for 
any deductions.         
  
Finally, enter any taxes and the Week Ending Date (W/E Date) this preissue will be given.  To access the 
Week Ending Date field, click in the W/E Date field or press Alt-X.  Press return to accept the date or 
enter a new date.  Fill each field as needed.  The cursor will travel from W/E Date to Soc. Sec., to 
Medicare then across the second row (Federal, State, DBL) and lastly to the Gross and Net fields.  The 
amount in the Gross field will equal the dollar amounts entered in the Preissue Line Items.  If this is not 
correct, check your entries and make any changes needed.  Note: The Gross amount cannot be entered 
directly.  Save the Preissue by clicking the “Save” button. 

 

In=Add

Out=Void

Deductions

Taxes

Employee

for this

entry
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Third Party Sick Pay Preissues 
 
To start entering a Third Party Sick Pay preissue select the employee that has the Sick Pay entry.  If this 
employee already has any preissues, they will show up in the Entered Preissues box.  To edit one of 
these preissues, double click on it and the information will be brought up.  If the employee does not have 
any preissues already entered, the screen will be brought up ready for a new preissue.  Otherwise, to add 
a new preissue, click the “New Preissue” button. 
 
For a new preissue, select whether this is an IN (add to totals) or an OUT (subtracts from totals) preissue 
by selecting the “IN” or “OUT” button under Preissue Type, in the upper left corner of the screen.  To 
make this a Third Party Sick Pay, select the “3rd Party Sick” option.  If the sick pay is “FICA Exempt,” 
select this option too. 
 
Click in the W/E Date field or press Alt-X.  The cursor will now be in the W/E Date field in the lower right 
area of the screen.  Enter a date for the sick pay or accept the one in the box.  If this is FICA Exempt sick 
pay, the only fields entered are: W/E Date, Gross, and Net.  For a nonexempt sick pay, all fields except 
DBL can be entered.  Once all the information has been entered, save the Preissue 
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Reports 
 
There are six reports built into Micropay: New Employees, Permanent Changes, Time Sheets, Preissues, 
Banking and Not Paid.  These reports are there to provide general information regarding your current 
payroll.  To access these reports, select the Reports menu or press Alt-R. 
 

 
 
There is an option in the Report menu to select Preview or Print.  Preview will display the reports on your 
screen at which point they can be reviewed and printed out.  Print will send the report directly to the 
printer. 
 

Reports included with Micropay:  
 
New Employees - Creates a one page report with complete information for each new employee entered 
for the current payroll.  When a new payroll has been started any employees entered on previous payrolls 
are no longer new. 
 
Permanent Changes - Creates a report with that displays any permanent changes made to employees 
on the current pay period.  The report shows the Employee with the old value of the field and the new 
value given to it. 
 
Time Sheets - The time sheet report resembles the filled in time sheet.  It shows the entries made for 
employees.  All fields with an entry are shown for each employee.  This report is useful for creating paper 
copies of your information for your records and/or for checking your entries.  Time Sheet reports can be 
sorted as follows: 
 
1. By Department and Employee Name: 
 
-Lists employees by department and displays department sub totals. 
 
2. By Department, By Employee (Employee Sub Totals): 
 
-Lists employees by department and displays employee sub totals. 
 
3. Summarized By Department: 
 
-Displays summaries by department. 
 
Preissues - The preissue report is similar to the time sheet report except that it displays only the 
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Preissues entered for each employee.  Only filled fields are printed on this report. 
 
Banking - There are two options for the banking report: “Pre-noted” or “all.”  The “Pre-noted” option 
allows you to view employees’ accounts that are pre-noted, but not yet active.  The second report is for all 
employees’ banking setups.  Both reports show all the banking fields and are sorted by employee 
number.  On the “All” banking report, all of an employee’s bank accounts are shown together. 
 
Not Paid - This report will display employees that have not been paid.  If an employee does not receive a 
pay entry, e.g., a 61 entry code on the time sheet, this constitutes an employee not being paid and thus 
they will appear on the Not Paid report.  This report can be useful when importing information from a time 
clock.  Run the Not Paid report after importing information from a time clock to verify employees have 
received pay entries. 
 
A custom report option is available for Micropay.  Contact ComputerSearch for more information. 
 
Reports Toolbar 
 
At the top of any report’s screen there is the Reports Toolbar. Using the toolbar you can: change the 
magnification of the display, print the displayed report, export the displayed report as a file or an email, 
and close the display.  Note: The Reports feature of Micropay uses a program called Crystal Reports™. 
Certain programs use different versions of Crystal Reports™; therefore the type of buttons and placement 
of the Reports Toolbar may be different on your computer than what is depicted below.       
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Reports Toolbar Buttons: 
 

 
1. Go To First Page – This button will return you to the first page of a multi page report. It remains inactive 
(grayed out) while page one is being displayed. 
 
2. Go To Previous Page – Clicking on this button will display the previous page of a multi page report. It is 
inactive when the first page of the report is being displayed. 
 
3. Page Number – This control shows the user which page is currently displayed and the total page count 
of the report. 
 
4. Go To Next Page – Clicking on this button will display the next page of a multi page report. It is inactive 
when the last page is being displayed. 
 
5. Go To Last Page – This button will display the last page of a multi page report. It remains inactive 
(grayed out) when the last page of the report is being displayed. 
 
6. Terminate Report Generation – Occasionally the user may realize that the wrong report has been 
selected. This button provides the ability to cancel the report generation process. This can be very useful 
when the mistakenly selected report is taking a long time to generate. 
 
7. Print Reports - This button will print the displayed report. When this button is clicked, it will bring up the 
print dialogue box.  You can choose to print “All” pages of the report or a selected range of pages. You 
may also select the number of copies and if whether or not the copies should be collated.  When you 
have finished making your choices, click the “OK” button to print the report. 
 

 

 
 
 Change magnification 
 Export this report 

 Print this report 

 Terminate report generation 

 Go to last page of report 

 Go to next page of report 

 Current page being displayed (of total pages) 

 Go to previous page of report 

Go to first page of report 
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The print dialogue also displays the printer being used.  Note: A printer must be setup for your computer 
in order to view and print any reports.  If you want to change the printer you must change the default 
printer through Microsoft Windows.  Consult your Microsoft Windows manual on how to setup a printer. 
 
8. Export Report: The export button provides several methods for exporting the report.  Clicking this 
button will bring up the Export dialogue box shown below. 
 

 
Export to a File 

The Export dialogue has two options: Format and Destination. Finished reports can be exported to a 
number of popular spreadsheet and word processor formats. The Format field allows you to determine 
the file type such as an Excel, Lotus 1-2-3, MS Word, plain text, Adobe PDF, and others. The Destination 
option allows you to export directly to a specific program (Application), saved to disk file, saved to 
Microsoft Exchange Folder, directly to Lotus Domino (v. 3.0+) e-mail client, or to Microsoft MAPI e-mail 
client.  By default “Disk file” is selected.  Choose this option to export the report to a file. Click the “OK” 
button once the desired format has been selected. 
 

 
 
The “Choose Export File” dialogue lets you select the file name and location for the exported report.  
Select the appropriate Drive and Folder location for the file.   Make any desired changes and then click 
the “OK” button.  The displayed report has now been exported to the specified file in the indicated file 
type. 
 
 
 



 

 62 

Export to an Email 
 

The export dialogue also allows you to export a report as an e-mail.  
Note: Destination will default to “Disk file.”  Click the down arrow, to the right, and select “Microsoft Mail.”  
 
Again, select the desired export format for the report.  Then click “O.K.”  

 
 
 
The Send Mail screen will ask for information needed to send an email.  Once you have finished filling out 
this screen, click “send.”  Your report has now been sent as an email. 
 
9. Change Magnification - This allows you to select predefined magnifications of the displayed report from 
a drop-down list.  Alternatively any integer percentage value desired may be selected by typing it into the 
box. 
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Time Sheet Control Totals 
 
The Time Sheet Control Totals area lets you decide what entries will be included in your totals, check 
totals for hours, pay and deductions.  Also included is Validate Payroll Entries, which prepares your data 
to be transmitted to ComputerSearch.  To access this area go to the Edit menu and then select Control 
Totals, press Ctrl-N or the Totals button.  
 
 

Setup Control Totals 
 

 
 
This screen will allow you to pick which entry codes are added to the totals and the pay types (Salaried or 
Hourly).  You may also choose to have the time sheet entries in the total only or the Preissues only, or 
both.  If you decide to have the Preissues count in the totals, “IN” or “OUT” Preissues may be selected. 
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Hours & Pay 
 
This screen displays the calculated totals for: Regular Hours, Overtime Hours, Other #1, Other #2, Temp 
Rate, Regular Pay and Overtime Pay.  There is a column called “My Totals,” where the totals may be 
entered manually.  Clicking the “ReCalculate” button will display the difference between “My Totals” and 
“Computed” totals.  If changes are made to any of the total entries, the “ReCalculate” button will need to 
be clicked again to see the changes.  Also displayed here are the Number of Checks issued and the 
Number of Preissued Checks. 
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Deductions & Taxes 
 
This screen displays the calculated Deduction totals for each Deduction field.  There is also a column 
called “My Totals” where totals may be entered manually.  Clicking the “ReCalculate” button will display 
the difference between My Totals and Computed totals.  If changes are made to any of the total entries, 
the “ReCalculate” button will need to be clicked again to see the changes.   Also displayed on the 
Deduction & Taxes screen is a computed Grand Total; this value may be entered manually under the “My 
Totals” column.  Again, clicking the “ReCalculate” button will recalculate the totals. 
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Validate Payroll Entries  

 
This screen is used to prepare the payroll data for transmission to ComputerSearch.  Click the “Begin 
Validation” button on the screen and wait until the validation process is finished.  Once the validation 
process has finished the “Payroll Status” window will display “Validated.”  The payroll is ready for 
transmission.  Click the “Transmit” button to go to the Communications area. 
 

 
 
 
Validate, then Click Transmit or if you have more than one payroll you may wish to finish up the others 
and transmit all the payrolls together. 
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Preview Payroll Journal 

 
Preview allows you to send a validated payroll and receive back a preview journal.  A payroll may be 
validated for preview at any point.  It is totally optional to do the preview.   You will send the payroll wait 
about 4 minutes, and receive your journal, which may be viewed for errors.  You may correct the errors 
and resubmit again for preview.   

 

 
 
Click Add All or click individual payrolls.  Click Start Communications.  The ‘Go online to check for 
preview...’ box will be checked for you and 4 minutes will count down before the program automatically 
checks for the preview journal that ran at ComputerSearch. 
 
Please close Adobe reader before sending another preview to ComputerSearch.   
 
When the preview journal is ready for viewing you will see the PDF file listed in the box above the ‘Go 
online…’ check box.  Double click on it to open the journal in Adobe reader. 
 
 
 
 
 
 
 
 
 

Transmit the Payroll 
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Click 'Add All' or if you have more than one payroll you maybe wish to send one by clicking on 

the payroll or click the 'Add All' button.  The payrolls in the 'Selected Payrolls to TRANSMIT' 

box are the ones that will be sent.  Click Start Communications when ready.  You may change 

the RUN DATE that ComputerSearch will run the payroll on.   
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Confirmation Numbers 

 
When transmitting your payroll for processing, you will receive a confirmation number and completion 
status. 

 

 
 
The Confirmation number contains the client number the date and time the payroll was transmitted.   
 
Completed: Payroll sent and your 
             Micropay database is  
             properly marked as  
             transmitted. 
 
  NOT Completed: Payroll sent but the 
             Micropay database is not 
             marked as such.  You will 
             not see the 'New Payroll 
             button' when you want to 
             start a new payroll. 
 
  NO CONFIRMATION: Payroll NOT SENT, try 
             sending again.              
 
  Note:  You may review this list again on 
             the client selection screen (the 
             screen after entering your password) 

 

 

 

 

 
The Client logon screen will now show if the payroll is Validated, the confirmation status or normal (you 
will just see the client number and name).  Normal means you are working on the payroll. 
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Receive Files 

 

 
 
When the payroll is processed at ComputerSearch your updated files are created.  These files are ready 
the day after you have sent the payroll.  If you had sent the payroll on Friday the files are ready on 
Tuesday as we do not normally process the payrolls till Monday.   Check off the Micromaster and Payroll 
History.  Some clients may receive ‘Special Files’, if so check the Special Files box.  Click Start 
communications to receive these files. 
 
They may be times when you might be told to only check the force update check box by someone at 
ComputerSearch.  This is mostly used to make sure you can communicate with us and does nothing to 
your data file.  You may use this option on your own to check your connection with us.   The option will 
only update your programs and report files, if needed.    
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Micropay Communications 
 
To access the Micropay Communications area, go to the File menu and select the Send/Receive option 
or on the Validate Payroll Entries screen click the “Transmit” button.  The Micropay Communications 
screen performs the following functions: the Communication process (send or receive files), making a 
diskette, and configuring the data connection to ComputerSearch. 
 

 
 
On the menu bar of the communications screen is the Maintenance menu.  In this menu are two choices: 
Citrix Program Neighborhood and Edit Micropay INI.  The Citrix Program Neighborhood provides access 
to the settings Micropay uses within the Citrix data communications protocol.  The Edit Micropay INI 
option allows you to display and modify the settings in the Micropay initialization file. NOTE: Making 
changes to either the INI file or the Citrix settings should ONLY be done with the guidance of the 
ComputerSearch technical staff.  Making changes here may make Micropay unusable, and/or unable 
to transmit or receive payroll data. 
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 Appendix A – State Codes List  

 

01 Alabama 
50 Alaska 
02 Arizona 
03 Arkansas 
04 California 
05 Colorado 
06 Connecticut 
07 Delaware 
09 Florida 
10 Georgia 
51 Hawaii 
11 Idaho 
12 Illinois 
13 Indiana 
14 Iowa 
15 Kansas 
16 Kentucky 
17 Louisiana 
18 Maine 
19 Maryland 
20 Massachusetts 
21 Michigan 
22 Minnesota 
23 Mississippi 
24 Missouri 
25 Montana 
 

26 Nebraska 
27 Nevada 
28 New Hampshire 
29 New Jersey 
30 New Mexico 
31 New York 
32 North Carolina 
33 North Dakota 
34 Ohio 
35 Oklahoma 
36 Oregon 
37 Pennsylvania 
52 Puerto Rico 
38 Rhode Island 
39 South Carolina 
40 South Dakota 
41 Tennessee 
42 Texas 
43 Utah 
44 Vermont 
45 Virginia 
46 Washington 
08 Washington, D.C. 
47 West Virginia 
48 Wisconsin 
49 Wyoming 
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 Appendix B - Employee Number Box  
 
The Employee Number box is found on the Time Sheet screen, to the left of the Employee list box. The 
Employee Number box is also available on the Select tab on the Employee Information screen. 
 

 
Time Sheet Screen 

 

 
 

Employee Information Screen 
 How to Use  

 
Type the desired employee number in the box and press the Enter key.  This will display that employee.  
If the selected employee is not available, an error message will display informing you that they are not in 
the list. 
 
Normally when the Time Sheet screen is brought up the first employee in the Employee list box will be 
highlighted and his/her employee number displayed in the employee number box.  As you pay each 
employee, the employee number box will display his or her number.  
 
If you want to use the Employee Number box instead of the Employee list box, to select employees, click 
in the Employee Number box, enter an employee number and press the Enter key.  That employee will 
then be displayed.  The cursor will be positioned in the Entry Code field and you can pay this employee.  
After you save that entry, the cursor will go back to the Employee Number box.  Enter the next employee 
number and press the Enter key.   
 
Note: The Employee Number box will not display the next employee number of the next employee 
displayed in the Employee List box.  You must enter each employee number. 
 
 
 

Selecting Terminated Employees  
 
The Employee Number box, on the Time Sheet screen, only has access to employees that are listed in 
the Employee List box; normally terminated employees are not listed along with active employees.  In 
order to gain access to terminated employees go to the View menu, then go to the Select option and 



 iii 

chose Terminated.  This will display only terminated employees and now you will be able to select 
terminated employees using the Employee Number box.
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